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1 Overview 

About this manual 

 This document describes the operation, functioning and installation as well 
as the technical data of the ZDUE Set software. This tool is used to operate 
the following products: 

• ZDUE-MOD-PLUS-IV 

• ZDUE-MOD-PLUS-V 

• ZDUE-GSM-PLUS-V 

• ZDUE-GPRS-PLUS-IV 

• ZDUE-LAN-PLUS-IV 

This applies right up to the current firmware, which is included in the ZDUE 
Set software package. 
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2 Introduction / Brief description 

 The following section is designed to help answer the basic questions you 
may have on the ZDUE Set software:  

What is the ZDUE Set? 

• What system requirements must be fulfilled for the use of this software?

• How do I install this software? 

• What do I have to do if I want to update this software? 

• How do I start up the software? 

• What will I see when I start the software? 

• How do I find out which software version I am using? 

Note 

For more detailed information, please refer to the product descriptions of the 
ZDUE-MOD-PLUS-IV, the ZDUE-MOD-PLUS-V, the ZDUE-GSM-PLUS-V, 
the ZDUE-GPRS-PLUS-IV and the ZDUE-LAN-PLUS-IV. 

2.1 What is the ZDUE Set? 

 The ZDUE Set is a Windows-based software to parameterize the ZDUE-
MOD-PLUS-IV, ZDUE-MOD-PLUS-V, ZDUE-GSM-PLUS-V, ZDUE-GPRS-
PLUS-IV and ZDUE-LAN-PLUS-IV meter modems. It enables the user to 
modify the parameters for the communication to the meter as well as the 
parameters for the internal load profile and for the communication to the 
control center. 

The ZDUE Set is a 32-bit application, based on a 32-bit environment that 
runs with Windows 95/98 as well as with Windows NT 4.X, Windows XP and 
Windows 2000. Win CE is not supported. 
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2.2 System requirements 

  In the following, you will find a list of the requirements for the use of the 
ZDUE Set: 

• IBM PC or a compatible PC with 60 MHz Pentium or higher equipped 
with the following features: 

• ≥ 16 MB RAM 

• CD ROM drive 

• At least one free serial interface 

• Supports COM ports: COM1 to COM16 

• Hardware components for communication 

• Internal or external analog or GSM modem for remote 
parameterization 

• LAN connection 

• CL1 adapter for the electrical interface (CL1 interface) on 
the ZDUE-MOD-PLUS-IV 

• RS232 cable for the RS232 interface on the ZDUE-MOD-
PLUS-V, ZDUE-GSM-PLUS-V or the RS232-
parametrization adapter for the ZDUE-GPRS-PLUS-IV and 
the ZDUE-LAN-PLUS-IV 

• Windows 95 / 98 / 2000 / NT / XP 

• Monitor with a minimum resolution of 600x800 pixels 

2.3 Installation / Update of ZDUE Set 

  Before you can install the ZDUE Set, you have to have administrator rights 
on your PC. We also strongly recommend that you exit all Windows 
programs before you run the setup. 

 The installation is started when you run the "Setup.exe" file in your 
installation package. Follow the instructions in the SETUP program. 
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 The SETUP program will suggest a destination folder for the installation 
directory: 

 

 

Figure 2-1: Installation – Choose destination folder 

 Use the Browse... button to access a dialog to alter the choice of the 
destination folder if desired.  

If you want to update the software, you are not required to deinstall the 
existing version. You can simply install the new version in the same folder. If 
you have already created a phone book in the old version, you should make 
sure that you back it up. For more detailed information, go to Chapter 
Fehler! Verweisquelle konnte nicht gefunden werden. “Fehler! 
Verweisquelle konnte nicht gefunden werden.”. 

SETUP will now check to make sure that there is enough memory available. 

After that, a communication window will open to show how the installation is 
proceeding. 

 

Figure 2-2: Progress 

 Following the successful completion of the installation, SETUP will indicate 
the following message: 
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Figure 2-3: SETUP completed 

 Attention: 

To make sure that the ZDUE Set program functions correctly, it is necessary 
to have at least one Windows system printer installed even if there is no 
printer connected. 

 Depending on the version of Windows you are using, you now have a 
program group (in the Windows Start menu under Programs -> ZDUEset) 
or a start icon for the ZDUE Set. 

2.4 Starting and using the software 

  To start the ZDUE Set: 

• Select the Windows Start menu -> Programs -> ZDUEset -> ZDUEset

• Or click on the desktop icon (if there is one) 

 To exit the software, select the sub-item “Quit” in the “File” menu.  

 Once the program has been started, the ZDUE Set start screen will appear. 

 The ZDUE Set program is a Windows-based application that also visually 
reflects the structure and set-up of Windows programs. 

Title bar 

Menu bar 

Icon bar 

 
Window section 

 
Figure 2-4: Start screen 

 The window of the main menu consists of 

• the title bar 

• the menu bar 

• the icon bar 

• the window section 
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 The title bar includes the title and information on the window opened, as is 
familiar in other Windows applications. 

 The menu bar indicates the menus available, in which the individual actions 
and switching functions are listed in plain text. This bar contains several 
different entries, which will be explained in the following chapters. 

 Submenus can be used to access other windows (document windows and 
dialog windows); the name of the submenu concerned appears in the title 
bar. 

 The menu bar contains a special menu, whose name indicates the currently 
selected device model. In Figure 2-4: , this menu is called “MOD-PLUS-IV”. 
In the following text, this menu will be referred to using the term “Model 
menu”.  

 The icon bar shows buttons (icons) for the most frequently used functions. 

 Some dialogs also include a bar with tabs that further divide to contents. 
These tabs appear below the icon bar. 
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Icon list 

 The following list indicates the icons available on the icon bar. 

 

Open.. 

 
Save.. 

 
Print 

 
Read register 

 
Read load profile 

 
Read GSM logbook 

 
Read settings 

 
Show settings 

 

Read/set date/time (VDEW) 

 
Read/reset status 

 
Reset load profile 

 
Show ONLINE communication protocol 

 
Information 

 
Read register (meter) 

 
Read load profile (meter) 

 
Write settings 
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Show the software version 

 To obtain information on the software version used, select the item “About 
ZDUE Set...” in the “Help” menu or click on the corresponding icon on the 
icon bar: 
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3 User settings 

 This chapter describes the menu items in the user settings, which can be 
found in the “Extras” or “Modem” menus. 

3.1 Communication 

 Select “Options” in the “Extras” menu and then go to the 
“Communication” tab. 

 

Figure 3-1: Settings – Communication tab 

Physical connection 

 The Physical Connection determines which connection paths are used to 
create a communication route between the control center and the ZDUE. 

 Modem 

When Modem is selected as the connection type, a connection to the ZDUE 
is set up via a modem connected to the control-center PC or an internal PC 
modem. The interface with which this modem is connected is set using the 
COM Port pull-down menu. In addition, a Modem input section of its own 
opens only for the Modem connection type. This is where you can set the 
parameters for modem communication (see below). 

 The Modem connection type must also be selected if you want to set up a 
connection to a ZDUE-GPRS-PLUS-IV or a ZDUE-LAN-PLUS-IV via a 
TAINY ComPortClient installed on the PC and the corresponding TAINY 
SwitchingCenter. In this case, the virtual COM port of the TAINY 
ComPortClient will be selected that is designated for this connection. 



User settings 

 

Page 14 of 62 ZDUE SET 

 COM Port 

The COM Port selection is used for the direct connection to a local ZDUE 
connected to the control center computer. The COM port to be used is 
determined in the COM Port pull-down menu. If the COM Port setting has 
been selected, the additional option 7,E,1 reception will be displayed in the 
“Data format” section. 

 “COM Port” pull-down menu 

The COM Port pull-down menu is used to select the COM1 to COM16 
interfaces on the PC. When the ZDUE Set is started, it automatically 
determines which COM ports the computer has. The PC user has to check 
to make sure that the COM port selected to be used by the ZDUE Set 
actually is available. The COM port is important for the Modem or COM Port 
connection types.

 IP 

Selecting IP means that the ZDUE-GSM-PLUS-V can be accessed via 
GPRS as long as it is running in the GPRS mode and has an IP server on 
top. The IP address of the ZDUE-GSM-PLUS-V and the port, on which the 
device ‘is listening’ have to be configured at this point (for information on the 
IP server, also see Chapter 6.7). 

The IP selection cannot be used for any other ZDUE models. 

 Data format 

The data format can be set to 7,E,1 and 8,N,1, depending on whether the 
parameters have been set by remote or locally or whether the PC modem 
used works with 8,N,1 only (also see the setting under Modem type). 

 Baudrate 

The baudrate between the PC and the PC modem for remote 
parameterization can, as a rule, be set to the maximum value. The PC 
modem used must be set to the same baudrate or it has to work with 
automatic recognition. 

 Create communication logfile 

When this option is selected, a communication logfile is created 
automatically and written into a file. These logfiles can be found in the main 
ZDUE Set directory in the “LogFiles” folder. 

 Suppress optical reflexion 

Suppressing optical reflexion only becomes necessary when the CL1 
adapter used for the local parameterization of the ZDUE-MOD-PLUS-IV via 
the CL1 interface does not automatically suppress optical reflexion or if the 
PC modem used for a remote parameterization does not support this 
function. 

 Prophylactic modem (SW) break at the beginning of the session 

If this function is activated, the ZDUE Set sends a break message to the 
ZDUE before transmission to the device address (IEC address). 



User settings 

 

ZDUE SET Page 15 of 62 

 Parameterization password 

Insofar as a parameterization password has been stored, it will be used for 
all read-outs and parameterizations. In this case, the parameterization 
password is not requested at the beginning of communication (this makes 
sense when the parameterization password is the same for several ZDUEs 
to be parameterized). If there is no parameterization password provided, it 
will have to be entered manually by the user for every read-out and 
parameterization. 

Modem 

 This is where the parameters are set for modem communication. They are 
required for the remote parameterization via a PC modem and only 
displayed when the Modem setting has been selected as the Connection 
type: 

 Keep connection  

Following the last data transfer between the ZDUE Set and the modem, the 
connection will not be immediately terminated between the PC and the 
modem. Once the time set here has elapsed, the connection is terminated 
and the modem hangs up. 

 Phone number 

The input screen for the telephone number is divided into two sections. The 
desired telephone number can be entered into the second field. If a phone 
book has been created, this information will be entered automatically once 
the corresponding phone book entry has been selected and activated.  

If it is necessary to get an outside line for the active entry in the phone book 
(see Chapter Fehler! Verweisquelle konnte nicht gefunden werden. 
“Fehler! Verweisquelle konnte nicht gefunden werden.”), these digits 
must be entered in the first field, in front of the actual phone number. The 
activated outside line number is indicated by @ placed in front of the phone 
number in the second field. 

 Also not numeric 

If this box is activated, it is also possible to enter non-numerical characters 
(letters) as the phone number. 

 Modem type 

Here it is possible to choose a modem type including the stored initiation 
from a list. The entries can be edited using the buttons marked New, Delete 
and Accept - and expanded as well. 

 Initialization 

In this field, it is possible to show and edit the initialization string for the 
modem selected. The correct initialization string for the PC modem used can 
be found in the modem manual. 
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 Local modem module processes (8,N,1) only 

This setting must be selected when the PC modem used does not support 
the 7,E,1 format. 

OK 

 Click this button to accept the current settings, i.e. to automatically save 
them so that they are available for the next start of the ZDUE Set.

Cancel 

 Click this button to ignore any modifications made and to close the “Options”
window. 

3.2 File 

 Select menu item “Options” under “Extras”, and then go to the tab marked 
“Files”. 

 Use this tab to enter the drives and paths in which the files are saved by the 
user by default. A click on “...” allows you to modify the entries. 

 The pull-down menu for the Proposal of file name(s) contains the entries 
made for “Date, serial number” and “Device identification”. Depending on 
your selection, the files to be saved will be assigned the parameters set in 
this menu as their default name. 

 Default path and name can be altered by the user prior to saving the file 
without having to change the entries in this tab. 

 

Figure 3-2: Settings – Files tab 
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 With the settings from Figure 3-2: Settings – Files tab, the following dialog 
window will open as the default path when you want to save a parameter 
set: “(C:\Programme\Neuhaus\ZDUEset\)ParFiles” and the date at the time 
of saving the file as the default file name (in this case: “20090921”) (the 
extension .PAR will be added automatically because this example involves a 
parameter file). 

 

 
Figure 3-3: Settings – Example for the Files tab 

  

3.3 General 

 Select the submenu item “Options” under “Extras”, and then the tab 
marked “General”. 

 

 
Figure 3-4: Settings – General tab 

Configuration 
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 This is where the general settings for the behavior of the ZDUE Set for 
parameterization and the read-out of parameters are made: 

 Edit passwords hidden 

If there is a checkmark in this box, the passwords in the ZDUE Set will be 
entered and displayed hidden, otherwise in plain text (e.g. the 
parameterization password in the “Extras” menu). 

 Read GPRS provider classes on request only 

If there is a checkmark in this box, there will be no request made for the 
provider classes when the device parameters are read out. 

 Check length of class while reading meter 

ZDUE Set will check the class length while reading out the modem 
parameters. 

Window state 

 This is where the size of the main window is determined: 

 Normal 

Normal sets a maximized window back to its previous size. 

 Default size 

The window size is set to a predefined size. 

 Full screen 

The window is set to maximum size. 

Print 

 This is where the printer font is determined in which the files from the ZDUE 
Set are printed. Click on “...” to change the font. 

Prefix for meter communication request 

 The prefix saved here is added to the communication request when the 
meter is read. If this field is empty, the meter will be sent the standard 
request “/?<Zähler-IEC-Adresse>!”. 

Date format for MS chart 

 This is where you can set the format of the time line (x axis) in graphs (e.g. 
the display of a read-out GSM logbook) for the ZDUE Set. 

Desktop language 
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 Use the pull-down menu to select which user language you want the ZDUE 
Set to work with. The following languages are available: German (DEU), 
English (GBR) and French (FRA). 

3.4 Device address modem 

 Select the submenu of “Device address modem” under “Extras”. 

 

 
Figure 3-5: IEC 1107 address 

 This is where an IEC1107 address can be entered that is automatically sent 
to the ZDUE with every communication. The ZDUE will only answer if the 
IEC1107 address sent from the ZDUE Set is identical to the address entered 
in its set of parameters (default: 99999999). If the address is not the same, 
the communication will be forwarded directly to the interface(s) to the meter.

3.5 Modify set password 

 Select the submenu “Change set password” under “Extras”. 

 

 
Figure 3-6: Change set password for communication 

 This menu can be used to set the parameterizing password used by the 
ZDUE Set. The parameterizing password in the ZDUE itself (default: 
00000000) will not be affected. This password is required to read out and to 
modify the parameters of the ZDUE. It expects 8 numerical digits. 

 If the option Edit passwords hidden has been activated under 
“Extras/Options” on the “General” tab, the parameterizing password will 
not be displayed in plain text at this point. 
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3.6 Phone book 

 If communication via modem has been selected under “Extras” -> 
“Options”, the “Modem” menu will appear in the menu bar of the ZDUE 
Set. It can be used to edit the phone book. 

 

 
Figure 3-7: Phone book 

 To select an existing phone book entry, mark the entry on the list and 

activate it with  (active). An active phone book entry appears on a yellow 
background and is displayed in the title bar. 

Creating new entries 

 To make a new entry in the phone book, you have to enter a subscriber in 
addition to a phone number for the ZDUE. In addition, it is necessary to 
enter the IEC address of the ZDUE (default: 99999999) and a password if 
the ZDUE is password-protected. 

There has to be a checkmark entered in the line box if it is necessary to dial 
to an outside line to connect to the ZDUE. In this case, the digits entered in 
the “Extras” -> “Options” -> “Communication” menu in the first field of 
the “phone number” will be dialed automatically before the actual telephone 
number (see Chapter 3.1 “Communication”). 

 
Click  (New) to add the entry to the list, click  (Accept) to save any 
changes made to existing entries. 

Click  (Delete) to remove the currently selected entry from the list. 
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Export/import phon  

 ed 

e book 

The entire phone book can be saved as a file and exported to be transferr

to a different computer or a new ZDUE Set version with  (Export file). 

Click  (Import file) to access an existing phone book. 

 

 
Figure 3-8: Open phone book 

Search phone book 

 
Click  (Search) to open a dialog to search the phone book for any term 
you enter.  

 

 
Figure 3-9: Phone book search screen 

 The first entry in the phone book to contain the search term will be marked 
by a black arrow in the left margin. 
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Figure 3-10: Phone book search screen 

 

Close phone book 

 
Click  (Exit) to close the phone book dialog. 
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4 Read ZDUE data 

 It is advisable to first check the communication. This is easiest to do using 
the Read settings command. If this doesn’t work, please check the user 
settings of the ZDUE Set, see Chapter 3, “User settings”. 

4.1 Read settings 

 The default model menu is named “GPRS-PLUS-IV” because the ZDUE Set 
doesn’t yet know whether it’s a ZDUE-GPRS-PLUS-IV or any of the other 
ZDUE models. This information will not be added until the settings are read 
out. 

 Go to the “GPRS-PLUS-IV” model menu and select the submenu item 
“Read settings” or the corresponding icon on the icon bar: 

 

 

Figure 4-1: Read out settings 

 This command makes it possible to read out and show the ZDUE settings. 
You will be prompted to enter the parameterizing password for this 
operation. 
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 The parameters that the current ZDUE model supports will be displayed in 
the following list: 

• Daylight savings time/standard time 

• Modem settings 

• General parameters 

• RS232 parameters 

• CL1 parameters 

• RS485/M bus parameters 

• eHZ parameters 

• GPRS parameters 

• LAN parameters 

• Primary server 

• Secondary server  

• Load profile/logbook parameters 

• Wireless communication parameters 

 Once the information on the ZDUE has been read out, an additional menu 
for “Modify” will be added to the menu bar. Use this command to modify the 
individual parameters (see Chapter 5 “Parameterizing the ZDUE ”). 

Click  (Exit) to close the display of the read-out parameters. 

4.2 Read load profile 

 In the Model menu, select the submenu item “Read load profile” or click 
the corresponding icon on the icon bar: 
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Figure 4-2: Read load profile 

 Use this command to read out the internal load profile of the ZDUE; it is 
formed by the three pulse inputs. The following settings can be made to read 
out a specific load profile: 

Period 

 This is where you can enter the starting and the ending point of the time 
period for the read-out data: 

 from 

If you set a checkmark in the box behind the input field, the beginning of the 
time window will be set to the first entry for the load profile. If you do not set 
a checkmark here, you can double-click the input window to open a dialog to 
freely define the time period yourself: 

 

 
Figure 4-3: Read load profile – Set date/time 
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 Edit boxes: Use the arrow keys to move from box to box and edit the values 
there. 

Date: Click on Date to enter the current system date in the edit box. 

Time: Click on Time to enter the current system date in the edit box. 

Use manually edited time: If this option has been selected, the data 
entered in the edit boxes will be used. 

Daylight savings time: Mark or unmark the Daylight savings time checkbox 
to set or delete the daylight savings time flag. 

Use actual PC time: If this option has been selected, the current system 
date and the current system time will be entered into the edit boxes. 

OK: The time and date set will be accepted; the dialog will close. 

Cancel: The dialog will close without saving the information entered. 

 to 

If you set a checkmark in the box behind the input field, the end of the time 
window will be set to the current time (PC system time) so that the load 
profile is read out until the last entry. If you do not set a checkmark here, you 
can double-click the input window to open a dialog to freely define the time 
period yourself. The dialog is the same as the dialog for the time period 
from. 

 Save  

If you want to read out a specific time period repeatedly, you can click this 
button to save it and select it again from Stored values under Time 
definitions. 

Time definitions 

 This section contains frequently used definitions that can be selected 
directly: 

Total: The entire load profile in the ZDUE will be read out. 

Stored values: The time last saved by clicking Save will be loaded. 

Last month 

Last week 

Yesterday 

Today 

Partial readout 

 If a checkmark is placed in this box, the load profile will be read out in 
blocks, i.e. using the R6 read command. 
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Show load profile 

 After you enter the time period, click Read load profile to read out the load 
profile of the ZDUE. Once all the data has been received, a new button 
marked Show load profile will appear. Click it to view the data on the load 
profile.  

 The following data will be listed in a table: 

• Date 

• Time 

• Channel values (always all 3 channels together) 

• Status of the measured periods saved 

 

 
Figure 4-4: Data on the load profile 

 
Click  (Exit) to close the display of the load profile data. 

 Note 

Reading out large LP data volumes: Only 1000 LP entries can be displayed 
in any one screen. If you read out a load profile with more than 1000 entries, 
you can view the additional entries by clicking the lines marked previous 
entries or following entries, which are in front of or following the entries you 
can see on the screen. 

4.3 Read GSM logbook  

 Select the “Read GSM logbook” submenu in the “GPRS-PLUS-IV” model 
menu:  

The time period for which you want to read out the logbook is set in the 
same way as for reading out the load profile (see 4.2) on the “Readout” tab.
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 The GSM status of the ZDUE is recorded in a non-volatile ring buffer in the 
GSM logbook of the ZDUE-GPRS-PLUS-IV. It contains automatic entries 
made by a timer and/or spontaneous entries caused by a specific event, 
such as: 

 • Change of a GSM operating parameter (e.g. of the network operator, of 
the registration status, of the PIN etc.) 

• Events in GSM communication (e.g. incoming or outgoing calls or a 
connection established) 

• Events in local communication (e.g. the successful readout of the billing 
data of the meter) 

• The ZDUE-GPRS-PLUS-IV was parameterized or a firmware update 
performed 

• Activation or deactivation of GPRS functionality by the respective 
control mechanisms  

• Automatic entry made by the timer (default: 10 min.) or when setting the 
date or the time in the ZDUE 

 An entry in the logbook always consists of the following elements: 

• Current time stamp 

• Cause of the entry (coded) 

• Signal strength (in dBm) 

• Registration status (coded) 

• Location area ID 

• Cell ID 

• Network operator 

 Once the information has been read out, you can look at it by clicking Show 
logbook. Two additional tabs are added to the “Read GSM logbook” dialog: 

Show logfile  

 The logbook contents are presented in a table. This view will be opened 
automatically when you click on Show logfile. 
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Figure 4-5: Data from the logbook 

 Below the table, there is an option to filter the table on the basis of specific 
criteria: 

 All  

The complete data set read out will be shown in the list. 

 No AUTO records 

Records marked with Automatic will be filtered out of the list so that only the 
“actual” events are shown. The data set read out is not changed. 

 Cause as selected 

The list will be reduced to all the records for one GSM logbook code. The 
code is selected in a drop-down menu that appears when this filter option 
has been selected. It contains all the GSM logbook codes or their 
translations known in the existing software version. 

 
Figure 4-6: GSM logbook – Cause as selected 
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Graphics 

 The logfile contents are shown graphically as a curve of the signal strength 
over time. 

 If a filter has been selected on the “Show logfile” tab by activating no AUTO 
records or Cause as selected, the corresponding records will be marked on 
the graph: 

 

 
Figure 4-7: GSM logbook – Graphical view with markings 

 Click Close to close the “Read GSM logbook” dialog. 

Only the ZDUE-GPRS-PLUS-IV is able to keep a GSM logbook. 

4.4 Read device status 

 Select the submenu item “Read/reset status” under “Commands” or click 
the corresponding icon on the icon bar:  
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Figure 4-8: Read status  

 Click Read in the dialog that opens to read out the ZDUE status. Any errors 
will be marked in red at the corresponding point. Green markings indicate 
that the corresponding status is OK, i.e. there are no errors. 

Click Reset to reset the errors saved in the device. 

Click Cancel to close the dialog. 

4.5 Read communication protocol 

 Click the following icon on the icon bar:  

 

 This function allows you to view the protocol of the last communication 
between the ZDUE Set and the ZDUE. In the event of an error, this can 
prove very helpful in determining at which point the error in communication 
occurred. The display appears in an external editor (e.g. Notepad). The 
ZDUE Set always saves the last 10 communication processes in .logfiles in 
the Logfiles sub-path in the installation folder.  

 Please note that a current communications protocol will only be recorded if 
the option of “Create communication protocol” has been activated in the 
“Extras” -> “Options” submenu on the “Communication” tab (see 3.1). 
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Figure 4-9: Read communication protocol 
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5 Parameterizing the ZDUE  

5.1 Open a parameter set 

 In the “File” menu, select “Open..” or click the corresponding icon on the 
icon bar: 

 

 This function allows you to open a parameter set file (file name extension 
*.PAR) in the ParFiles sub-path in the installation folder: 

 

 
Figure 5-1: File menu, Open 

 Load profile files (*.LG), logbook files (*.LOG) and register files (*.RD) that 
are available in a format that the ZDUE Set can read can also be opened 
using this dialog. 

5.2 Save a parameter set 

 Select “Save” in the “File” menu or click the corresponding icon on the icon 
bar:  
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 This command opens a dialog window so that you can save the readout 
data. 

This data includes: 

Parameter file: The file is saved with *.PAR as its default extension. 

Load profile contents: The file is saved with *.LP as its default extension. 

Register contents: The file is saved with *.RG as its default extension. 

GSM logbook: The file is saved with *.LOG as its default extension. 

 Note: 

It will not be possible to save this information unless the corresponding data 
has already been read out of a ZDUE or loaded using the submenu item 
“Open..” (see 5.1 “Open a parameter set”) (screen display). 

5.3 Parameterizing a ZDUE using File 

 Select the submenu item “File -> <Device type>” in the “File” menu. 

This menu can be used to load all the parameters in a parameter file (*.PAR 
extension) and send them to the modem. 

Before the write command is performed, the ZDUE Set will, under certain 
circumstances, open another dialog that can be used to read out or set the 
ZDUE system time during the parameterization. If this dialog is confirmed 
with “Yes”, the “Modem time check” will open. Its function is described in 
Chapter 7.1. 

If you answer with “No”, the device will be parameterized directly, otherwise, 
after the “Modem time check” dialog is closed. It is no longer possible to 
cancel the parameterization process at this point. 

 Note: 

Please note that this function will overwrite all the parameters in the ZDUE 
with the settings of the parameter set loaded. 

 

 

 

 

 

5.4 Modify parameters 
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 Use the “Modify” menu item to modify, save and reload the parameters of a 
ZDUE or a file into the device.  

This menu item will not appear unless the settings of the ZDUE have already 
been read out (see Chapter 4.1 “Read settings”) or directly loaded in a 
parameter file (see Chapter 5.1 “Open a parameter set”). 

After changing the parameters, the corresponding menu item must be 
confirmed with “OK” to send the new parameter values to the ZDUE. The 
following prompt will appear: 

 

 
Figure 5-2: Data transfer 

 Click Yes to write the data directly in the ZDUE. If you click No, the process 
will not be performed but the data will be recorded in the ZDUE Set 
database. 

This is the general procedure to modify the parameters. An exact description 
of the individual parameters is provided in the following chapters. 
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6 Configuration of the ZDUE parameters 

 Select “Modify”. 

 

Figure 6-1: “Modify” menu item 

6.1 Settings for daylight savings time/standard time 

 This is where you can specify the switching dates between daylight savings 
time/standard time for the ZDUE’s real time clock for the next ten years. 
These dates can be calculated automatically using either the EU standard 
(EC Standard button) or you can define the times manually. A switching 
point to be changed is marked in the table and the date is set with a slide 
control. Select standard time/daylight savings time to determine when the 
clock will be switched: 

 • Standard time:  03:00h 

• Daylight savings time: 02:00h 
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Figure 6-2: “Daylight savings time/standard time” menu 

 Among other things, the switching table is required for the correct time 
behavior of the internal load profiles of the ZDUE-MOD-PLUS-IV/ZDUE-
GPRS-PLUS-IV/ZDUE-LAN-PLUS-IV from the three pulse inputs. 

6.2 Modem settings 

 This menu can be used to set all the parameters for the communication 
between the PC modem and the ZDUE: 

 

 
Figure 6-3: “Modem settings” menu “ 
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 Accept call/period 

The ZDUE will accept incoming calls only within the time period set. This 
function assumes that the clock in the ZDUE is set to the correct time so that 
the system time is the same as the real time. That’s why a reset of the clock 
in the ZDUE will be suggested automatically when any changes are made in 
the time window parameters and it should also be altered accordingly. 

 Data transfer/data format 

For the connection between the PC modem and the ZDUE, the data format 
can be set to 7,E,1 or 8,N,1. This is required because not all of the control 
center modems are able to process the 7,E,1 format. 

 Timeouts 

If there is no data connection to the ZDUE or the connected meter for the 
duration of the Communication timeout, the ZDUE will automatically 
terminate the connection. The TA and TR timeouts are specified in the 
IEC1107 protocol. 

 Password/call-back 

If password protection is activated in the ZDUE, it must be set here. A ZDUE 
with password protection will prompt the user to enter a password after the 
connection has been set up by CONNECT (message: “Please Login:”). If the 
password is not entered within 10 seconds, the ZDUE will terminate the 
connection. In addition, it is also possible to activate the call-back function in 
combination with password protection. In this case, the ZDUE hangs up after 
the password has been entered and dials the telephone number stored for 
the control center 5 seconds later. 

 GSM parameters (only for the ZDUE-GSM-PLUS-V, ZDUE-GPRS-PLUS-
IV) 

This is where you can alter the PIN of the SIM card and specify a network 
provider (useful close to borders to avoid expensive roaming), as well as 
select the GSM transfer rate and the reset time including the interval for the 
GSM module in the ZDUE-GSM-PLUS-V or ZDUE-GPRS-PLUS-IV. 

6.3 Identifications 

 This function allows you to modify the IEC1107 address, the 
parameterization password and the EVU identification of the ZDUE. Please 
make sure that the address of the ZDUE is different to the IEC addresses of 
the meters connected to ensure unique addressing in communication. 
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Figure 6-4: “Identifications” menu 

6.4 Meter parameters 

 This menu is used to set the interface parameters for communication with 
the meters connected to the ZDUE. The CL1 parameters apply in the same 
way for all the existing interfaces for the ZDUE-MOD-PLUS-IV, the ZDUE-
MOD-PLUS-V and the ZDUE-GSM-PLUS-V. 

 

 
Figure 6-5: “Meter parameters” menu 

Selection of the interface type 

 Active interface type  
(ZDUE-GPRS-PLUS-IV, ZDUE-LAN-PLUS-IV only)  

This is where you specify which interface the ZDUE uses for communication 
to a connected meter.  
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Standard parameters for all interfaces 

 The different interfaces each have the same standard parameters: 

 Starting baudrate modem meter 

This value must be the same as the parameterizing baudrate in the meter. 

 Data format 

This value must be the same as the parameterizing data format in the meter.

 Physical break after “close connection”  

Is sent when activated to terminate undesired communication from the meter 
and to clear the interface for further communication. 

 Break length 

This parameter determines how long the physical break should last on the 
line to the meter. 

 Data transmission 

Transparent (fixed baudrate): The data is transmitted purely transparently 
between the meter and the control center using the starting baudrate set. 

Mode C (according to IEC1107): The ZDUE first determines the baudrate 
to the meter and automatically sends this information to the control center. 
After that, the data is transmitted transparently between the meter and the 
control center. 

Additional parameters for the RS-232 

 There is also the following parameter for the RS232 interface (ZDUE-GPRS-
PLUS-IV and ZDUE-LAN-PLUS-IV only): 

 DTR signal active 

The DTR signal can be either always active or only switched to active during 
an existing connection to the ZDUE. 
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6.5 Load profile/logbook parameters 

 

 
Figure 6-6: “Load profile/logbook parameters” menu 

 These parameters are available for the ZDUE-GPRS-PLUS-IV, the ZDUE-
LAN-PLUS-IV and the ZDUE-MOD-PLUS-IV only. 

Length of demand period 

 The length of the demand period can be set to 1, 2, 3, 5, 15, 30 or 60 
minutes. It applies in the same way for all three channels. 

Channels 

 This is where the parameters for the individual load profile channels can be 
set: 

 Counting pulse is triggered by ... 

The type of edge that triggers a counting pulse (raising or falling edge). 

 Minimum pulse length 

Minimum length of a pulse so that it is counted. 

 Identifier 

The EDIS identifier for the medium to be measured. 

 Unit 

The physical unit of the medium to be measured. 
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6.6 GPRS parameters for the ZDUE-GPRS-PLUS-IV 

 

Figure 6-7: “GPRS parameters” menu 

 This menu contains the GPRS and server parameters of the ZDUE-GPRS-
PLUS-IV, providing that the device is equipped with this functionality (ZDUE-
GPRS-PLUS-IV, firmware version V2.XXX): 

Network provider settings  

 Network provider settings 

The network provider settings contain a list with GPRS registration 
information for 10 possible network providers, which can be freely specified 
by the user. The ZDUE-GPRS-PLUS-IV adopts the provider data and the 
GPRS parameters according to the SIM card from this list. The first four data 
sets are preset at the factory to the following German network providers: T-
Mobile, Vodafone, E-Plus and O2. 

 The number buttons are used to select an entry that is to be modified. As 
long as not all the input fields are filled, the corresponding number button will 
light up in red. Once the data has been entered, it is allocated to the entry by 
clicking Accept. The next time the ZDUE is parameterized, the new settings 
will be written into the device. 

 Cancel cancels out any modifications made to a provider entry that have not 
yet been accepted. 
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Basic settings 

  To log onto a TSC (TAINY SwitchingCenter) or CPS (TAINY 
ComPortServer)1, the ZDUE-GPRS-PLUS-IV requires the login data from 
the Basic settings: 

 Log-on information 

This section contains the log-on information for the TSC or CPS. The data 
can be specified for two different servers (Server1, Server2): 

 Hostname/IP address: Server address of the TSC/CPS application. 

User name for the logon of the ZDUE-GPRS-PLUS-IV to the TSC/CPS. 

Password for the logon of the ZDUE-GPRS-PLUS-IV to the TSC/CPS. 

Destination and source port must be the same as the settings of the 
TSC/CPS. 

Connection attempts: If the server is not available, the number of attempts 
entered here will be made. This function is available for Server1 only. 

Special GPRS attach: If this function is activated, the GPRS detach will be 
effected by a GSM module restart. This function is available for Server1 
only. 

 Server for logon 

The selection of the logon server determines which protocol the ZDUE uses 
for communication via GPRS: 

 • TAINY SwitchingCenter 

• TAINY ComPortServer 

 Connection parameters 

Bandwidth: Determines the number of downlink and uplink channels. You 
can choose between “4 downlinks/1 uplink” and “3 downlinks/2 uplinks”. 

Delay time [min] for re-establish: Delay time for a new GPRS attach, 
following the termination of the GPRS connection or for a faulty re-establish. 
This parameter no longer appears from FW version 2.100. 

Delay time [mSec] IP packets: Meter data is sent to the control center 
once 1024 bytes have been received or after the delay time set here has 
expired.  

                                                      
1 System to connect meter modems via GPRS/Internet to ZFA systems, more detailed information is 
available from Dr. Neuhaus Telekommunikation GmbH 
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6.7 GPRS parameters for the ZDUE-GSM-PLUS-V 

 

 
Figure 6-8: “GPRS parameters” menu 

 This menu contains the GPRS parameters of the ZDUE-GPRS-PLUS-V, 
providing that the device is equipped with this functionality (ZDUE-GSM-
PLUS-V for GPRS, firmware version V3.XXX): 

Network provider settings 

 The network provider settings contain a list with GPRS logon information for 
two possible network providers, which can be freely defined by the user. The 
ZDUE-GPRS-PLUS-V adopts the provider data and the GPRS parameters 
according to the SIM card from this list. The two data sets are preset at the 
factory to the following German network providers: T-Mobile and Vodafone. 

 The number buttons are used to select an entry that is to be modified. As 
long as not all the input fields are filled, the corresponding number button will 
light up in red. Once the data has been entered, it is allocated to the entry by 
clicking Accept. The next time the ZDUE is parameterized, the new settings 
will be written into the device. 

 Cancel cancels out any modifications made to a provider entry that have not 
yet been accepted. 

Basic settings 

 The ZDUE-GSM-PLUS-V operates on an IP server in GPRS mode and 
waits for a fixed port after receiving the connection request from a client. The 
parameters required for this are set here: 

 GPRS enabled 

If this option is activated, the ZDUE-GSM-PLUS-V is operating on an IP 
server. If the checkmark is removed, GPRS functionality will be deactivated 
and the ZDUE can only be reached locally and via GSM. 
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 Server port (receive) 

TCP port, at which the ZDUE waits for incoming connection requests from a 
client. 

 Timeout at GPRS login fail 

If a GPRS login fails, a new attempt will be made after the timeout expires. 

 No. of GPRS connection attempts till module reset 

Once this number of connection attempts has failed for the GPRS login, the 
GSM module will be restarted. 

 Wait time for re-login after x GPRS login fails 

After the number of GPRS login fails configured here, the ZDUE will wait the 
amount of time entered here before it makes any new GPRS login attempts.

6.8 LAN parameters  

 

 
Figure 6-9: “LAN parameters” menu 

 This menu contains the LAN and server parameters for the ZDUE-LAN-
PLUS-IV. These parameters are available for the ZDUE-LAN-PLUS-IV only.

 

Network settings 

 This is where the parameters of the ZDUE Ethernet interface are managed. 



Configuration of the ZDUE parameters 

 

Page 46 of 62 ZDUE SET 

 Local IP address 

The IP address of the Ethernet interface. 

 Local subnet mask 

The mask of the subnet in which the device is located. 

 Gateway address 

Address of the gateway used for the connection to the WAN. 

 DNS Server1 

First DNS server address (DNS: Domain Name System). This is the address 
of a DNS server that changes a domain name into an IP address. 

 DNS Server2 

Second DNS server address. 

 DHCP enabled 

If the DHCP (Dynamic Host Configuration Protocol) is enabled, the ZDUE 
will be automatically assigned its local IP address, the local subnet mask, 
the gateway address and the two DNS servers. In this case, it is necessary 
for a DHCP server to be working in the subnet in which the ZDUE is located.

If the DHCP is enabled, the text boxes for the Local IP address, Local 
subnet mask, gateway address, DNS Server1 and DNS Server2 cannot be 
edited. 

 PPPoE enabled 

This option makes it possible to operate the ZDUE-LAN-PLUS-IV directly at 
a DSL connection. If PPPoE is enabled, an additional field will appear in 
which you have to enter the access data of the DSL provider: 

 

 
Figure 6-10: “LAN parameters – DSL provider data” menu 

 

Basic settings 
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 To log onto a TSC (TAINY SwitchingCenter) or CPS (TAINY 
ComPortServer)1, the ZDUE-LAN-PLUS-IV requires the following data: 

 Sign-in parameters 

This section contains sign-in information for the TSC or CPS. Data from two 
different servers can be entered here (Server1, Server2): 

 Hostname/IP address: Server address of the TSC/CPS application 

User name for the ZDUE-LAN-PLUS-IV logon to the TSC/CPS 

Password for the ZDUE-LAN-PLUS-IV logon to the TSC/CPS 

Destination and source port must be the same as for the TSC/CPS  

Connection attempts: If the server is not available, this is the number of 
connection attempts that will be made. This function is available for Server1 
only. 

Server mode 

 The selection of the server mode determines which protocol the ZDUE will 
use for communication via the LAN interface: 

 • TAINY SwitchingCenter 

• TAINY ComPortServer 

LAN logging enabled 

 Activates/deactivates the creation of a LAN logbook in the ZDUE-LAN-
PLUS-IV 

Data format 

 Data format of a logical connection established between the ZDUE-LAN-
PLUS-IV and a control center. 

TimeOut – for sending readout packet 

 Meter data is sent to the control center once 1024 bytes have been received 
or after the delay time set here has expired. 

6.9 eHZ parameters 

 These parameters are available for the ZDUE-GPRS-PLUS-IV only. 

                                                      
1 System to connect meter modems via GPRS/Internet to ZFA systems, more detailed information is 
available from Dr. Neuhaus Telekommunikation GmbH 
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Figure 6-11: “eHZ parameters” menu 

 Starting from FW version 2.3xx, the ZDUE-GPRS-PLUS-IV is able to receive 
data from an electronic household meter (eHZ) connected and record it in a 
load profile. In addition, a monthly reset of the measured values can be 
activated for two different tariffs. All the parameters required for the eHZ 
mode are specified in this dialog: 

eHZ mode 

 Activates/deactivates the eHZ mode. 

eHZ interface 

 This section specifies to which physical interface of the ZDUE an eHZ is 
connected: 

 • CL-1 

• RS 232 

• RS 485 

• M-Bus 

Reset 

 This section specifies the parameters for resets: 

 eHZ reset T 1 

Activates/deactivates the reset for tariff 1. 
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 eHZ OBIS ID for reset T 1 

At this point, the ID or part of the ID searched for in the eHZ data set is 
parameterized. The value assigned to the ID is used for the reset for tariff 1.

 eHZ reset T 2 

Activates/deactivates the reset for tariff 2. 

 eHZ OBIS ID for reset T 1 

At this point, the ID or part of the ID searched for in the eHZ data set is 
parameterized. The value assigned to the ID is used for the reset for tariff 2.

Load profile 

 This section is used to set the parameters for recording the load profile: 

 Load profile 

Activates/deactivates the load profile recording. 

 Load profile decimal 

The values communicated from the eHZ have more places than can be 
presented in the load profile. This parameter indicates the number of 
decimal places that are to be shown in the load profile. 

Times 

 This defines the timing for the eHZ mode: 

 Break length msec  

eHZ timer – determines how much time can pass between the starting and 
end ID of an eHZ data set before the ZDUE declares the data set to be 
invalid. 

 eHZ Service Timeout Sec 

ServiceTimer_1 – determines the maximum time that can pass between the 
receipt of two characters at the physical interface. If this time is exceeded, 
the ZDUE-GPRS-PLUS IV will switch into the service mode. 

 eHZ Service Timeout Sec 

ServiceTimer_2 – determines the length of time that can pass between the 
end of the service mode and the restart of ServiceTimer_1. This makes it 
possible, for example, to disconnect the parameterizing computer from the 
ZDUE after performing a local parameterization and to connect the eHZ 
before the device switches back into the service mode.  
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6.10 Display settings 

 

Use this menu item or the corresponding icon  to display the 
parameters currently set in the ZDUE Set in a list in the main window (also 
see Figure 4-1: Read out settings). 

 Any modifications made in the settings will go into effect after they have 
been confirmed in the corresponding dialog with “OK” and then the “Display 
settings” function is activated. 
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7 ZDUE commands 

 Select the “Command” menu item. 

 

 
Figure 7-1: Command menu 

 Use this menu to send formatted commands to the ZDUE, whereby not 
every command is available for every model. The “Command” menu adapts 
to the ZDUE selected. 

7.1 Read/set date/time (VDEW) 

 In the “Command” menu, select the submenu item “Read/set date/time 
(VDEW)” or the corresponding icon on the icon bar: 
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Figure 7-2: Read/set date/time (VDEW) 

 The real-time clock in the ZDUE can be set in the window for “Set 
date/time”. There are two modes to select from: 

 Use manually edited time 

Use the arrow keys below the editing fields to set an individual time/an 
individual date. Use the daylight savings time checkbox to set or delete the 
daylight savings time flag. 

Use actual PC time 

If this mode is used, the current PC time/PC date will automatically be 
transmitted to the ZDUE. 

 Use the Date button to set the date editing fields with the current PC date, 
the Time button to set the PC time. 

The Set date and Set time checkboxes can be used to determine which data 
set are to be written into the device. This setting is valid for the transfer of a 
manually set time as well as the PC time. 

The Set button writes the date set (date and/or time) into the device 
connected. 

Use the Read button in the Read date/time window to read out and display 
the current system time of the ZDUE connected. 

7.2 Read/reset status 

 See Chapter 4.4 “Read device status”. 

7.3 Select COM interface 

 This command is available for the ZDUE-GPRS-PLUS-IV and the ZDUE-
LAN-PLUS-IV only. 
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 Select “Read/reset status” in the “Command” menu.  

 With this function, it is possible to switch the interface to the meter for the 
ZDUE-GPRS-PLUS-IV and ZDUE-LAN-PLUS-IV online, i.e. during an 
existing connection. This means, for example, from the CL1 to the RS232 
interface. In this way, all the interfaces can be addressed during a 
connection between the control center and the ZDUE-GPRS-PLUS-IV or the 
ZDUE-LAN-PLUS-IV and the meters connected read out. 

 This temporary switch will not affect the active interface set in the “Meter 
parameters”. As a result, the parameterized interface will first be used the 
next time a connection is established to the ZDUE-GPRS-PLUS-IV or 
ZDUE-LAN-PLUS-IV (also see 6.4 Meter parameter). 

 The ZDUE Set performs this interface switch after the selection has been 
made with a separate command at the beginning of the next request. This 
command is /?COMPORT#x!. 

 The x stands for the number of the corresponding interface: 

1 CL1 
2 RS232 
3 RS485 
4 M-Bus 

 

 
Figure 7-3: Select COM interface 

7.4 Reset load profile 

 This command is available for the ZDUE-GPRS-PLUS-IV, the ZDUE-LAN-
PLUS-IV and the ZDUE-MOD-PLUS-IV only. 

 In the “Command” menu, select the submenu item “Reset load profile” or 
the corresponding icon on the icon bar: 
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Figure 7-4: Reset load profile 

 Click Yes to reset the ZDUE-internal load profile, i.e. all load profile entries 
will be deleted. Click No to cancel the function; the load profile entries will 
not be affected. 

7.5 Delete GSM logbook 

 This command is available for the ZDUE-GPRS-PLUS-IV only. 

 In the “Command” menu, select the submenu item “Delete GSM 
logbook”. The following dialog will appear: 

 

 
Figure 7-5: Delete GSM logbook 

 Click Yes to delete the entire logbook for the recording of the GSM status. 
Click No to cancel the function, all the GSM logbook entries will remain 
unaffected. 

7.6 Reset PIN error 

 This command is available for the ZDUE-GPRS-PLUS-IV and the ZDUE-
GSM-PLUS-V only. 

 In the “Command” menu, select the submenu item “Reset PIN error”.  

 If a SIM card is inserted in a ZDUE-GPRS-PLUS-IV with a PIN that does not 
match the PIN stored in the ZDUE-GPRS-PLUS-IV (default: 0000), the 
device will revert to PIN error status, indicated by the red, flashing status 
LED. In this status, the ZDUE-GPRS-PLUS-IV will not continue to attempt to 
book into the GSM network to avoid having a block put on the SIM card after 
three incorrect PIN entries. In this status, the ZDUE-GPRS-PLUS-IV can be 
accessed locally only. 

 To reactivate the GSM/GPRS mode for the ZDUE-GPRS-PLUS-IV, the PIN 
error has to be reset using a local parameterization via the RS232 interface.
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 First read out the ZDUE settings and find out what PIN is stored in the 
ZDUE. After that, use a cell phone to set the PIN of the SIM card to the 
number set in the ZDUE and put it back into the ZDUE-GPRS-PLUS-IV. 

 Please note that the device always has to be switched off before the SIM 
card is removed or inserted. 

 After this, the “Reset PIN error” command can be executed. The ZDUE Set 
opens a dialog, in which the PIN common to the ZDUE-GPRS-PLUS-IV and 
the SIM card must be entered: 

 

 
Figure 7-6: Reset PIN error 

 Once the PIN error has been reset, the status LED will light up in green and 
the ZDUE-GPRS-PLUS-IV will attempt to log into the GSM network. 

7.7 Reset modem  

 In the “Command” menu, select the submenu item “Reset modem”. The 
following dialog will appear: 

 

 
Figure 7-7: Reset modem 

 Click Yes to restart the device. This corresponds to a disconnection and re-
establish of the ZDUE supply voltage. Click No to cancel the function, the 
ZDUE will not restart. 

7.8 Factory settings 

 In the “Command” menu, select the submenu item “Factory settings”. 
The following dialog will appear: 
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Figure 7-8: Set factory settings 

 Click Yes to reset all the parameters in the device to the factory settings. 
The device will then restart and has to be reconfigured for operation. Click 
No to cancel the function; the ZDUE configuration will remain unaffected. 

7.9 Read hardware configuration 

 This command is available for the ZDUE-GPRS-PLUS-IV only. 

 In the “Command” menu, select the submenu item “Read hardware 
configuration”. 

 Use this command to read out such hardware properties as memory sizes. 
Click Read in the dialog that opens to send the command to the ZDUE. 
Cancel closes the dialog without reading out the hardware properties. 

 When this command has been performed successfully, the data will be 
shown in the corresponding text boxes of the “Read hardware configuration” 
dialog: 

 

 
Figure 7-9: Read hardware configuration 

7.10 Change password 

 This command is available for the ZDUE-GSM-PLUS-V only. 

 Use the “Change password” command in the “Command” menu to 
change the meter modem password of a ZDUE-GSM-PLUS-V. The following 
dialog will open: 
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Figure 7-10: Change password 

 The Old password field automatically contains the previous meter modem 
password of the ZDUE insofar as its data has already been read out. After 
the new password is entered in the field marked New password and 
confirmed by clicking the OK button, the new password is set in the ZDUE. 
Click Cancel to close the dialog without changing the password. 

7.11 Optimized download 

 If this option is deactivated, an Xmodem download will be performed with a 
packet size of 1 kilobyte. With this relatively small packet size, it will take a 
long time to transfer a large volume of data, particularly on the GSM network 
because each data packet has to be confirmed by the receiver. If the 
optimized download is activated, the packets 10 kilobytes in size will be 
used, which serves to significantly accelerate the transfer process. 

7.12 Firmware update 

 In the “Command” menu, select the submenu item “Firmware update” to 
load new firmware into the ZDUE. The update is performed using the 
communication path set under the “Options” menu item (“Communication” 
tab) under “Extras” (e.g. local or per GSM). The update cannot be started if 
there is an active connection to the ZDUE. The following dialog can be used 
to disconnect any existing connection before the update: 

 

 
Figure 7-11: Firmware update 

 Click Yes to disconnect existing connections and to continue with the update 
process. Click No to keep the existing connections and cancel the update 
process. 
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 Insofar as the update process is continued, select the corresponding 
firmware file from the dialog that opens: 

 

 
Figure 7-12: Firmware update 

 The Firmware files of the individual ZDUE models are different from one 
another. For the ZDUE-GPRS-PLUS-IV and the ZDUE-LAN-PLUS-IV, select 
a corresponding Firmware file with the extension (*.bin) and for the ZDUE-
MOD-PLUS-IV, ZDUE-MOD-PLUS-V, ZDUE-GSM-PLUS-V a file with the 
extension (*.hex). The files for the individual models can be filtered out in the 
File type drop-down menu. After the selection has been made, a program 
will be started that establishes a modem connection, if necessary, and 
performs the update. Once the procedure has been completed, there will be 
a message output indicating that the update was successful or that an error 
occurred. 

7.13 Read register (meter) 

 The ZDUE Set enables communication directly with the meters connected to 
a ZDUE. This serves primarily to check whether and meter is correctly 
connected and communication is possible after a ZDUE plus meters have 
been installed and configured with the ZDUE Set. 

 To read the meter register, select the submenu item “Read register 
(meter)” in the “Command” menu or the corresponding icon on the icon 
bar: 
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 Please note that the “Read register” function and the “Read register (meter)” 
function both use this icon. Use the direct help function to find out which icon 
this is. Simply hold the cursor directly on the button without moving or 
clicking it. 

 
Figure 7-13: Direct help: Read register (meter) 

 To access a meter, it has to be addressed. ZDUE Set will first ask the user 
for the IEC address of the meter to be read out. 

 

 
Figure 7-14: Request for IEC address 

 The default setting is no IEC address because a meter can also react to the 
request string without an address “/?!”. This setting is only practical for 
interfaces that have only one meter connected. As soon as multiple meters 
are connected to one interface, they have to have unique IEC addresses 
and to be addressed individually to be read out (e.g. with “/?11111111!”). In 
this case, a request with “/?!” would lead to an overlapping of meter 
responses because all of the meters would react in the same way to the “/?!” 
address. 

 After the transfer of the request string, the ZDUE knows that it is being 
addressed at its own address and forwards the data to the active meter 
interface. The meter addressed receives the request and responds 
accordingly. The ZDUE Set presents the register data as follows: 
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Figure 7-15: Meter register data 

7.14 Read load profile (meter) 

 The ZDUE Set enables communication directly with the meters connected to 
a ZDUE. This serves primarily to check whether and meter is correctly 
connected and communication is possible after a ZDUE plus meters have 
been installed and configured with the ZDUE Set. 

 To read out the meter-internal load profile, select “Read load profile 
(meter)” in the “Command” menu or this icon on the icon bar: 

  
 Please note that the “Read load profile” function and the “Read load profile 

(meter)” function both use this icon. Use the direct help to find out which icon 
this is. Simply hold the cursor on the button without moving or clicking it. 

 
Figure 7-16: Direct help: Read load profile (meter) 

 To access a meter, it has to be addressed. ZDUE Set will first ask the user 
for the IEC address of the meter to be read out. 
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Figure 7-17: Request for IEC address 

 The default setting is no IEC address because a meter can also react to the 
request string without an address “/?!”. This setting is only practical for 
interfaces that have only one meter connected. As soon as multiple meters 
are connected to one interface, they have to have unique IEC addresses 
and to be addressed individually to be read out (e.g. with “/?11111111!”). In 
this case, a request with “/?!” would lead to an overlapping of meter 
responses because all of the meters would react in the same way to the “/?!” 
address. 

 After that, you can enter the information for the load profile readout (see 4.2 
Read load profile): 

 

 
Figure 7-18: Meter load profile 

 The further procedure for the user and the behavior and presentation by the 
ZDUE Set are analog to the “Read load profile” function and described there 
(see 4.2 Read load profile). 
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8 The connection doesn’t work! What now? 

 If you experience any problems while trying to establish a functioning 
communication path to the ZDUE, use the following checklist to help you: 

 • Is the COM port correct for the PC modem connected? 

• Is the phone number activated in the phone book the correct one? 

• Is the IEC address of the ZDUE correct? 

• Is the initialization string of the modem connected to the computer 
correct? 

• First test “Read settings”. 

• Does the ZDUE dialed respond? 

• Does the ZDUE send data (see communication protocol)? 

• Is the parameterizing password used correct? 

• Are you using the correct data format (7,E,1 ; 8,N,1)? 
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